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LAB BASICS 
 
 
I just don’t know what to do. Can you help? 
 
Our staff is here to help you when we can. However, this lab is a self-service lab. Please 
remember that there are typically two staff members working at a time and as many as sixteen 
patrons in the lab. Our staff does have other tasks to tend to, so we may not be able to sit down 
and work with you for extended periods, but we will do our best to reasonably assist you. 
 
If you need help learning how to use a computer in general, ask about the classes we offer. Each 
class lasts approximately 90 minutes covering a broad range of basic topics. The classes cost 
$2.50 per session, and typically run in pairs. The first two classes you must take are Computer 
Basics 1 & 2, which start from very beginning use of a computer, and are designed primarily for 
anyone who has never really used a computer. 
 
 
I’ve never used a computer before. How do I do things on it? 
 
The first thing you need to do is make sure you are comfortable moving a mouse. Any time you 
hear “click”, that means use the left button. If the cord is facing away from you, the arrow on the 
screen moves exactly the way the mouse does. To start a program, you will need to click on the 
icon – the little picture for it – once and hit the enter key. (Or you can push the button twice 
quickly; this is known as double-clicking.) 
 
 
Which program should I use? 
 
If you want to get on the Internet to look for a job, print a map, or send e-mail, you will want to 
start Internet Explorer. The icon for that is a blue letter ‘e’. Go to the Using the Internet section 
beginning on page 14 for help with the Internet. 
 
If you are interested in typing a text document of some kind – a letter, a resume, a book report, 
etc. – you will want to use Microsoft Word. Look for the letter ‘W’ in a box to find the Word 
icon. There is also a section in this guide for using Word on page 24. 
 
If there is another task you want to perform in the lab and don’t know how, ask one of the staff 
members for assistance. Note that the computers do not allow you to save directly onto the 
computer itself, which means you cannot install any kind of programs we do not already have. 
 
 
More general computing questions can be found on later pages. 
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LAB POLICIES (Using the Lab) 
 
Who can use the lab? 
 
Anyone over the age of 12 who can provide a valid Montgomery County library card with no 
outstanding fines or overdue items. Children under the age of 12 can use the computers upstairs 
in the Children's Department. 
 
 
Do I need a Norristown library card to use the lab? 
 
No, any library card with a blue MC-NPL Internet User sticker will work. (Blue is for adults; 
there are other colors.) If you do not have an active library card, or forgot it at home, you can 
also get a one-day “access granted” pass from the circulation desk if you have a valid ID. 
 
 
How long can I stay? 
What happens if the lab is full? 
 
You can stay as long as you need to, unless one of two things happen: 
1) We are closing. The lab closes half an hour before the library for the night, and also 
sometimes closes for classes once or twice per day. 
2) The lab is full. If the lab is full and new patrons arrive, we refer to the check-in list and ask the 
person who has been here the longest to leave. You are guaranteed a minimum of 30 minutes in 
the lab, under this situation. If you are the person waiting for an opening, we will place your 
name on a waiting list and page you when a computer is freed. Because we ask current patrons to 
leave in this situation, the process should only take a few minutes. 
 
If you are asked to leave, that means we need you to leave. We try to be understanding, but we 
cannot really make exceptions and still be fair to all. Is the man viewing auctions on E-bay 
performing a serious activity or leisurely surfing the web? It’s not our place to judge. We do not 
expect you to X out of your program instantaneously, but you do need to finish your activity and 
leave to be respectful to the other lab users. 
 
 
If this is a library, do I need to be completely quiet? 
 
While we do tolerate some minimal amount of noise, in the interest of not disturbing the other 
patrons, we ask that you do not cause a commotion, and most importantly, please turn your cell 
phones off, or put them on vibrate and take your calls outside. 
 
If you want to listen to music or other sound on the computer, there is a headphone jack at the 
base of every monitor. If you don’t have your own headphones, you can purchase a basic pair at 
the check-in desk for $1.00. 
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LAB POLICIES (Rules and Regs) 
 
 
Can two people use the lab together? 
 
Yes, but they must both check in. You are permitted to use the same computer if you like, but we 
do not allow more than two people at one computer. Exceptions are made for children in 
strollers. 
 
 
What activities are not allowed in the lab? 
 
The following are not permitted in the lab: 
• Cell phone usage 
• Eating, drinking, or gum-chewing 
• Disruptive or uncooperative behavior 
• Viewing nudity (which generally applies to images revealing private areas) 
• Vandalism, violence, or other misdemeanors 
 
Failure to comply could cause one of the following: 
• A verbal warning 
• A 30-day suspension from the lab 
• A permanent ban (from the lab or the library, case depending) 
 
Repeated infractions then escalate to the next type of penalty. 
 
 
Do you have a webpage? 
 
Yes! You can visit the library at www.mc-npl.org. The computer lab has a link on the library 
main page. (MC-NPL = Montgomery County – Norristown Public Library.) 
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LAB POLICIES (Computer-Related) 
 
Can I print things? 
 
Yes. After the first three text pages, we do charge to cover our costs: 15 cents per text page, or 
more if there are pictures involved. If you are unfamiliar with printing in the lab, we ask that you 
contact one of the staff to ensure you do not accidentally print 10 pages when you meant to print 
1. See page 17 for details on how to print. 
 
The printer is behind the check-in desk. You can either retrieve your prints as you leave, or you 
can come to the check-in desk and request them. Please be patient if there are other patrons at 
check-in, and do not get them yourself. Be mindful that you will have to pay for any page that 
prints from your computer, regardless of if you want it or not. 
 
 
Can I look at / use my _____ in the lab? 
 
Probably. Any disk, thumb drive, CD, or USB device such as a digital camera can be viewed. 
However, keep in mind that we do not have CD burners to save onto CDs or DVDs, and that you 
cannot store information to the hard drive, which means that you cannot run a program you 
bought or bring in (such as TurboTax) here. 
 
 
How do I save? 
What if I don’t have a place to save to? 
 
The lab sells floppy disks at a price of $1.00, or 50¢ for a used disk if any are available. If you 
choose to purchase a disk, you must take it home with you. (Put your name on it in case you 
leave it here.) We also sell zip disks if you need more storage space; however they cost $15 each 
and are not nearly as common outside the lab. Once you have your disk: 
 
1. Place it in the floppy drive – the lowest slot above the power button on the computer – with 
the label face up, and the metal part going into the computer first. 
2. Go to the file menu and choose “Save As…” 
3. Check the destination of the file next to the “Save in:” box at the top. If it doesn’t already read 
“3 ½ floppy (A:)”, click on the box and change it to that. (If you are saving somewhere other 
than the floppy, then choose that option instead.) 
4. Give your file a name by clicking in the box, erasing the old name with backspace and delete, 
and typing in your new name. Then press the Save button in the lower-right corner. 
 
If you are unsure about this process, or want to save something other than an entire document or 
webpage, ask one of the staff members for assistance. 
 
Do you have a scanner / Fax machine? 
 
Sorry, no, we do not offer these services. 
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GENERAL COMPUTER (The Mouse) 
 
How do I work the mouse? 
 
Feel free to ask one of the staff to show you the mouse tutorial for a nice introduction to using 
the mouse. 
 
At the simplest level, make sure the wire for the mouse is always facing away from you. Put your 
hand lightly on the back part of the mouse so your index and middle fingers rest over top of the 
two buttons. Don’t push down on them, and ignore the wheel between the buttons for now. 
 
Roll the mouse side to side, and forward and back, and you should see the arrow on the screen 
move along with your hand. If you run out of space moving the mouse, you can pick it up and set 
it somewhere else that lets you keep rolling – notice that the arrow will not move when the 
mouse is in the air. 
 
The left mouse button is the one used for all the clicking. Hold the mouse still with your outer 
fingers while pushing the button with your index finger. Keep your hand the way it was before – 
do not pick it up to poke at the button. Otherwise the mouse will slide slightly, and this can make 
different things happen. Also, do not hold the button in. Just a short push, like you would an 
elevator button. 
 
There is also a technique known as “double-clicking,” where you click the button twice quickly. 
A double click is usually a shortcut way to do something else, so don’t be frustrated if you can’t 
double click. Double clicks are often used to start a program from the desktop. The right mouse 
button is used for bringing up quick menus for options. Unless you are comfortable with a 
computer, you will probably not use the right mouse button for anything. If you accidentally 
click the right mouse button and a window pops up with choices in it, find an empty part of the 
screen and left-click there to make the menu go away: Make sure you do not actually click on the 
menu that pops up. 
 
 
Why did my pointer turn into something else? 
 
The simple answer is that it changed because of where it is. The cursor has several different 
shapes depending on what it is pointing at. Most of the time the shape is an arrow, but it can be 
other things as well. It will turn into a pointing hand if you are pointing to an internet link, or it 
could turn into an “I-beam” if the mouse is over a block of words, for example. 
 
 
What is double-clicking? 
 
Double-clicking is a technique of holding your mouse completely still, and quickly pressing the 
left mouse button two times in a row. This method is most often used on desktop icons to launch 
the program they represent. In almost any other case, double-clicking is not necessary, and can 
actually be harmful to what you are doing, so do not double-click unless there is a reason for it. 
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GENERAL COMPUTER (The Mouse) 
 
Why did this gray box appear in the middle of my screen? 
 
You probably pushed the right mouse button. Clicking the right mouse button will always give 
you a menu with a list of choices related to the item you clicked on. To remove the menu, point 
your mouse pointer to a clear area away from the menu, in a place where nothing would 
normally happen if you just clicked (such as the title bar), and click your left mouse button. 
 
 
What is highlighting? Why did my words turn blue? 
 
Highlighting is a technique that calls a computer’s attention to a particular part of the screen or 
the document. Once you have made the computer focus on that section, you can then perform 
other actions such as copying it or changing the size of the letters. Sometimes highlighting is 
referred to as selecting. 
 
To highlight part of a document or webpage, move your mouse pointer to the very left edge of 
the beginning of the section. Your pointer should turn into an “I-beam” that you need to put 
immediately in front of the beginning. At that point, hold your mouse button down, and do not let 
go until you reach the end of the area you want to highlight. When you get there, let go of the 
mouse button. 
 
Be careful when highlighting not to let go of the button at any point. All the computer cares 
about is the start and stop points, so as long as you start in the right place, you can go all over the 
screen and the computer will only care about where you let go. But if you do make a mistake, 
click in a clear area and everything will un-highlight so you can try again. Note that this will 
happen if you click in the main part of the screen for ANY reason, so once you have something 
highlighted, only click if you mean to. 
 
 
What is “copy and paste”? 
 
Copy-and-paste is a very powerful tool for taking information and moving it some place else. If 
you have something highlighted, and you go to the Edit menu at the top of the screen and choose 
“copy”, the computer will remember that selection. If you then have the computer look at some 
place where you could put that same information, go to the Edit menu again and choose “paste” 
and it will insert the copied data right there. 
 
Next to copy, there is also an option called “cut”. Cut works exactly the way copy does, except 
that it also takes your selection away. If you cut-and-paste, it typically means you want to move 
something rather than simply duplicate it somewhere else. 
 
The beauty of copy-and-paste is that it can be done between programs. For example, if you see 
some information on the Internet that you like, you can copy it, open Microsoft Word, and paste 
it into a document. 
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GENERAL COMPUTER (The Keyboard) 
 
How do I type? 
 
If you want to type anything, you will first need a place to type it in. This can be a small text box 
on a webpage on the internet, or it can be an entire Word document. You will be able to type if 
you see a blinking line somewhere on the screen. The official name for this blinking line is the 
“insertion point” or the “text cursor”, but most people just call it the cursor or the blinking line. 
 
The cursor marks the spot where your typing will go. If you press one of the letters on the 
keyboard, it will add it next to the blinking line…and if all you wanted to do was type letters and 
numbers, that would be very simple. However, there are quite a few other important keys on the 
keyboard to know about: 
 

• The space bar is the long broad key in the bottom row. Pressing it moves your cursor 
forward a little bit, just like you would want to do to separate two words. 

• The enter key is at the right end of the main part of the keyboard. There is a second enter 
key all the way to the right. The enter key is used for starting new lines. In other 
situations, the enter key can also be a sort of “go” button. 

• The shift keys are at the left and right ends of the lettered area on the keyboard. If you 
need to type a capital letter, hold down one of the shift keys while you press the letter you 
want to capitalize. Also, when two symbols are printed on a key, (such as the numbers on 
the top row.), you will get the lower symbol normally. If you hold the shift key, you will 
get the upper symbol instead. 

• The caps lock key on the left side of the keyboard is used for making everything you type 
a capital letter. It is not often you will want to use this key, but if you find that everything 
you are typing is capitalized, press the caps lock key to turn that mode off. 

• The arrow keys between the letters and the numeric keypad are normally used for moving 
the blinking line around. The “home”, “end”, “page up”, and “page down” will also move 
the cursor to the beginning and end of the line you are on, or up and down about a page 
length on your work. 

• The backspace key lets you erase whatever is to the left of your blinking line. Use it to 
back up and remove mistakes in your typing, including times you press the space bar or 
enter key. 

• The delete key removes whatever is to the right of your blinking line. It works the same 
way as the backspace key. 

 
These are just some of the keys that you will use most frequently. 
 
 
How do I learn to type? 
 
The simple answer is just to practice. Once you are familiar with the keyboard, try to keep your 
hands still over the keys in the center rather than poking at each key with your index fingers. On 
the desktop in the lab, we do have a program called MC-NPL Typing Tutor that will give you 
things to type if you want to practice. 
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GENERAL COMPUTER (Screen Layout) 
 
What am I looking at on the screen? 
 
Assuming you are on a logged-in computer without any programs running, you probably see the 
desktop, which has a blue background with a bunch of little pictures all over it. The desktop is 
what shows if there is nothing else to see, and gives you an easy way to access programs. The 
little pictures are called icons, and you can click on one and press enter (or double-click it) to 
begin the program it represents. 
 
If you have a program open, it will be in a window, which might be part of or the entire screen. 
You will know for sure if you see a blue bar across the top of the screen called the title bar. The 
left side of the title bar says which program is being run, and at the right side are three buttons, 
the last of which is an X. If you want to quit out of that program, you can close it by clicking on 
the X. 
 
Below the title bar is the menu bar, which has a set of words on it, usually starting with “File” 
and “Edit”. Clicking on any of these words opens a menu of choices. You can then click on those 
options to activate them, or click in a clear space to collapse the menu. 
 
The third row down, and possibly fourth and fifth, are bars with little pictures on them. These 
pictures are called toolbars, and they provide quick access to tools you can find in the menus. 
You can find out what a given button is for by pointing your mouse to it without clicking. 
 
Sometimes the screen will have other items at the top or bottom of the screen such as a ruler, 
another toolbar at the bottom, or a status bar that explains the current situation of your work. 
(How many pages your document has, whether your webpage has finished loading, etc.) The 
status bar would be at the bottom of the window, second from the bottom of the screen. 
 
At the very bottom of the screen will always be a task bar, with a start button at the left end, and 
the clock at the right. The center section shows the names of the programs that are currently 
running. Because of this, the task bar is very important to managing the computer. 
 
 
How do I close this…thing…somebody else left running? 
 
Click the X in the upper-right corner. Say no if it asks you if you want to save. 
 
 
How do I get a program out of the way without quitting it completely? 
 
There are a few ways, but the easiest is to hide the window. Of the three buttons in the upper-
right corner, click the one on the left. It should minimize your program, and you will bring it 
back when you click its name on the taskbar at the bottom of the screen. 
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GENERAL COMPUTER (Screen Layout) 
 
 
How do I change the size of a window on the screen? 
 
If the program is taking up the whole screen, you need to first push the middle of the three 
buttons on the title bar, labeled “Restore Down”, so it will stop using the whole screen. This 
button will say Maximize instead if the window is already only part of the screen, which makes it 
take up the whole screen again. 
 
When you put your mouse pointer over the border of a part-screen window, it will turn into a 
two-way arrow. If you hold the mouse button in and drag the mouse back and forth, you can pull 
that edge of the window to a different place, either inward or outward. If you do this on a corner, 
you can adjust the window both horizontally and vertically. 
 
 
What does the Start Menu do? 
How do I log out when I’m done? 
 
The Start button in the bottom-left corner of the screen opens a menu that provides access to all 
the programs the computer has available, as well as certain other tools. 
 
To use the Start Menu to open a program, click on the start menu and slide your mouse up to the 
word Programs. There is no need to click on Programs. Then move straight across into the new 
section of menu that appears with the list of programs, and *then* slide up to the program you 
wish to run and click on it. This is a single click, not a double-click like you would use with 
icons on the desktop. 
 
The Start Menu is also the tool you would use to log off the computer when you are finished 
working. There is no need to do that here in the lab. Please do not log off the library 
computers. However, if you were some place else, you would click on the Start Menu, and 
rather than going to programs, you would go to the bottom option of Log Off instead. Some 
computers might ask you how you want to log off -- simply leave the computer yourself for 
someone else to use, turn it off completely, or restart it. 
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GENERAL COMPUTER (Scrolling and Hardware) 
 
 
I think there’s more to what I’m looking at than what I can see. How do I see the rest? 
 
If you are looking at something that has more information than the computer can show you at 
once, there is a very good chance you will need to use a scroll bar. The scroll bar will be all the 
way to  the right edge, and looks like a tall bar with a smaller block somewhere inside it. Think 
of that as an elevator inside a shaft. Sometimes the shaft is only two floors, so the elevator takes 
up a lot of that space. Sometimes the building is thirty stories tall, and the elevator is really tiny. 
How big the block is helps you know just how much of the document or webpage you can see 
right now. 
 
If you want to look down, you will need to scroll the screen by doing one of three things: 

1) Click on the down arrow at the bottom of the scroll bar. 
2) Click in the area between the “elevator” and the bottom of the shaft. 
3) Hold your mouse button down while pointing at the elevator, and move the mouse down. 

 
If you want to go back up, the same methods apply in reverse. 
 
 
What’s this thingy on the (physical) computer? 
 
There are a few parts to the computer. The viewing part is the monitor, a.k.a. the screen. (Please 
don’t touch the screen.) You type on the keyboard and move the arrow pointer (cursor) with the 
mouse. All of the other pieces of the computer are connected with wires to one box on the floor 
to your right called the case or the tower, which is the actual computer itself. The front of the 
case has openings for a CD drive, a zip drive, and a 3 ½ inch floppy drive. Next to the zip and 
floppy drives are USB ports for plugging in things like cameras and thumb drives. 
  
Inside the computer are three other important parts – the hard drive, the motherboard, and the 
central processing unit (CPU for short). The hard drive is like a disk drive, except that it stays 
inside the computer and holds much, much more information than a disk. On private computers, 
most information is stored to the hard drive, however in the computer lab you are not permitted 
to save your work to the hard drive. The CPU is the “thinking” part of the computer. It decides 
what the computer should be doing at any given time. The motherboard is what links all the other 
pieces of the computer together, including a few other things not discussed here. 

 12



GENERAL COMPUTER (Programs and Files) 
 
Just what is a program? 
 
A program is anything that lets you actually do something on the computer. Common programs 
include Microsoft Word and Internet Explorer. A more technical explanation would be that a 
program is a series of instructions for the computer to follow for performing a particular task. 
 
 
What is a file? 
 
A file is just a big bunch of computer information in one package, that can be separated from the 
rest of the computer’s information. Anything you do or access, directly or indirectly, is a file. 
Files can be programs (computer commands), documents or pictures (your work that you save), 
or any number of other things. 
 
 
How are files set up in the computer to separate them? 
 
The file structure of the computer is the layout of all the files in the computer. Most files will be 
on the hard drive, and there are literally thousands upon thousands of them, so the computer 
treats the hard drive like a BIG file cabinet. If you have a lot of pieces of paper to store in that 
cabinet, you can put them on top of the cabinet, but that isn’t very organized. So you put them in 
different drawers of the cabinet, probably by some kind of category. But even then, there are still 
too many of them, so you put dividers in the drawer, and then probably put small folders in the 
dividers, and just put the things very closely related in the same folder. 
 
The computer does the same thing, except we call all the “drawers” and “dividers” folders. 
Inside a folder might be more folders. When you need to find a particular file on the computer, 
you need to make sure you know where to look for it. Most of the time when you save 
something, it goes somewhere you can recognize, but it’s best to make sure. Common places to 
save files are the desktop, your floppy disk or a folder on the floppy disk, or the “My 
Documents” folder. (My Documents is not usable in the Computer Lab because it is part of the 
hard drive.) 
 
 
How does the computer tell files apart? 
 
Every file has a name and an extension. For example, this list of questions is typed in a file called 
FAQ.doc – FAQ is the file name that was given to it (for frequently asked questions), and the 
extension ‘.doc’ on the end tells the computer that this is a DOCument. Extensions are usually 3 
letters long after a period, and are shorthand for what kind of file it is. For example, one type of 
picture file is a .PIC. A program is usually .EXE to mean that it is EXEcutable. 
 
Note that Internet addresses also have an extension on them, such as .com – this is very similar, 
but it is not the same thing. 
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USING THE INTERNET (General) 
 
Exactly what is the Internet? 
 
The Internet is a collection of computers world-wide that are all linked together and able to 
communicate to each other in a limited fashion. The most commonly-used part of the Internet is 
the world wide web, which has all the webpages and other Internet sites that are meant to be 
visited by anyone. It also includes e-mail, which is handled on page 19. 
 
How do I get on the Internet? 
 
The program you want for using the Internet here in the lab is Internet Explorer. “IE” is known 
as a web browser, and there are several other similar programs, such as Netscape, Firefox, and 
Opera, and AOL has it’s own if you subscribe to their service. If you are using something other 
than Internet Explorer, some of the buttons might be in different places, but the method should 
stay the same. 
 
All the internet pages in the world have a web address, which usually looks like 
http://www.something.com where the “something” can be just about anything, and there could 
be stuff tacked onto the end after a slash. If you are looking for a company’s website, chances 
are, the something is their name. www.pepsi.com, for example. (The ‘http://’ part is mostly a 
formality, and you can leave that part off.) 
 
To actually go to that page, you need to type the address in the address field near the top of the 
screen, and press enter. It will probably already have something in it you need to erase, (the 
default in the lab is www.yahoo.com,) and that is usually as easy as clicking once in the field and 
then starting to type. Note that this is not the same blank as the “Search:” box.
 
 
What is the “Search:” box for then? 
What do I do if I don’t know the name of where I want to go? 
 
If you want to go somewhere that you don’t have a specific address for, either because you have 
a particular place and just don’t know the address, or because you are simply looking for pages 
related to some topic, you will want to use a search engine. Search engines, like Yahoo and 
Google, go out and look for every page they can find that have something to do with the things 
you want to look for. Our web browser defaults to Yahoo’s main page, which has a blank you 
can use to type in what you are looking for. 
 
When you choose what to type, it’s usually better to keep it to one or two specific words. For 
example, if you wanted to find out what the score was for the Penn State football games played 
in October, you would probably start by typing in “Penn State football”. After you hit search, 
you will get a list of the first (up to) 20 matches the engine found, and it will probably tell you 
that it found a whole lot more. After some brief information on what is on the page, there will be 
a hyperlink to that page to go to it. If none of the websites seem to be what you want, there is an 
option at the bottom of the screen to go to the ‘next’ page and see the second set of 20 matches. 
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If there are simply too many pages and you don’t see anything close to what you want, you can  
go to the top and change your search. If the issue you have is too many pages, just add something 
else to the end of the line to narrow things down. In the football example, maybe you would add 
“October scores 2007”. Order does not matter. 
 
If you see a listing for a page that looks like what you want, click on the hyperlink – the blue 
words that are probably underlined – and you will jump to that website. Hyperlinks are not 
always blue or underlined, but they will be at Yahoo or Google. 
 
 
What if I still can’t find it? 
Can I really find anything on the internet? 
 
It’s said you can find anything on the internet. There are millions upon millions of pages on the 
internet. But there is only what other people have put there. If you were doing research on your 
family history, and wanted to know about your great-grandfather, it’s quite likely nobody ever 
made a page related to your great-grandfather, and so it simply might not exist. 
 
The other extreme is that there is so much junk out there, that it might just be extremely difficult 
to sort through it all for exactly what you want. 
 
 
What’s a hyperlink? 
 
A hyperlink is a section of text that is usually a different color and underlined, and changes the 
mouse pointer to a hand. If you click on those words, they will take you immediately to another 
webpage that should have something to do with the subject of those words. 
 
A hyperlink can also be part of a picture, which sometimes tells you more about the picture or 
shows a bigger version of it. If your cursor turns into a pointing hand, the mouse is over a 
hyperlink and will be taking the web browser to another page on the internet if you click. 
 
 
What’s the difference between a webpage and a website? 
 
That depends on who you ask, but most people consider the website the overall location on the 
internet, and the actual webpage to be the particular part of that site you are looking at. For 
example, “http://www.philly.com/mld/inquirer/”  is the home page for the Philadelphia Inquirer.  
“www.philly.com” is the website, and the “/mld/inquirer” part indicates the section of that 
webpage that refers to the Inquirer. Think of the site as the zip code and the page as the street 
address. 

 15



USING THE INTERNET (Navigating Webpages) 
 
What’s a home page? 
 
A home page can mean two different things. For an average user, a home page is the place the 
browser starts when you get on the internet. In the lab’s case, this is yahoo.com. You can also 
press the home button, that looks like a house at the top, to return to this place. For a big website, 
the home page is like the front lobby – it’s the place you go to ask around for the exact place you 
want to go.  
 
Do I really have to remember all these web addresses? Is there a speed dial or something? 
What’s a bookmark/favorite? 
 
The point of being able to use a computer well is to get the computer to do all the work for you, 
and one of the things a computer does very well is remember stuff. 
 
If you visit a particular webpage, and it is either a very useful site you might not be able to find 
again, or it is a place you find yourself visiting routinely, you might bookmark it. To do this, you 
would just go to the Favorites menu, (we recommend the pulldown MENU, not the button,) and 
click on “Add to Favorites”. The computer will ask you to give the page a name for your 
reference, and then it will keep track of that page for you ever after. 
 
To return to that page, go to the Favorites menu and find it on the list that appears. Click on it 
and the computer will immediately go to that website. 
 
You can also put favorites into folders to organize them. Note that because this is information 
stored directly onto the computer, the lab machines will not save your bookmarks. 
 
 
This page is taking too long and I changed my mind. How do I stop it? 
This page isn’t what I wanted. How do I get out of here? 
 
Webpages are often very quick to load, but they are not always instant. BE PATIENT. You will 
know if the computer is working if (a) the colored Windows flag in the upper-right corner is 
moving and/or (b) the status bar, which is the bar near the bottom of the screen just above the 
task bar, says something other than “done”. Even then, the computer could be working still, but 
that’s usually how you know. 
 
If a webpage is still loading, do not start clicking furiously. The old page you were looking at 
might still be visible, and if you click the hyperlink, it can restart the loading process making you 
take extra time, or make other things happen. Just wait for it. 
 
However, if the page is taking a very long amount of time to load, you might consider canceling 
your request to look at it. First press the stop button, which looks like a piece of paper with a red 
X on it. Then press the button marked “back”. 
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The back button returns you to whichever page was the last one you were viewing before this 
one. If you press the back button several times, you can retrace your steps all the way to where 
you first began. 
 
 
The webpage doesn’t look like it loaded correctly. How do I fix it? 
The webpage has old information on it. How do I get it to update? 
 
If you have either of these problems, it could very well be that the page is the way it’s supposed 
to be, or at least the problem is beyond your control. However, sometimes webpages do load 
funny, or the computer remembers the way the page looked the last time you were there and puts 
that on the screen. If you want to try getting the computer to try again, press the refresh button, 
which looks like a piece of paper with green arrows pointing in a circle. 
 
The refresh button is helpful if the information on a page is quickly changing – which is not the 
case for most webpages, but it is for some – or if the webpage did not load fully. However, if one 
refresh does not fix the problem, chances are the issue is simply on the other end and there is 
nothing you can do. The webpage simply has old information or isn’t working. 
 
 
How do I print a webpage? 
 
The literal answer is that you go to the file menu and select print. However, there are a few 
things to be careful of, and so we recommend you do something else first. Under the file menu is 
also a choice called Print Preview. This will let you see exactly what you will be getting on your 
print-out before you print it. This is important because sometimes the computer is focused on a 
piece of the page rather than the whole thing, or the webpage will go onto more pages than you 
desire. 
 
When you are in Print Preview, the arrow buttons next to the page markers will let you move 
between your actual print-out pages to see what will be on each. Pay special attention to the last 
page, as very often you will get random junk at the bottom. 
 
You can leave Print Preview by pressing the button marked “Close” on the toolbars. If the 
computer is focused on the wrong part of the page, leave print preview and click on a different 
part of the screen and try again, or highlight the areas you want. Now when you go to Print from 
the File Menu, you can use some of the other choices on this screen to control what you print. On 
the left side, you will notice that the computer will want to print All pages. You can specify to 
only print certain page numbers or the selection you have highlighted. Choose that option instead 
(and type in the page numbers) if you need to, and THEN press the print button. 
 
Please remember that when you print in the lab, you are responsible for everything that you 
cause to be printed, and will have to pay for anything besides the first three text copies. If you 
are uncertain about what to do, consult with one of the lab staff. 
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USING THE INTERNET (Filling Out Forms) 
 
How do I apply to this website? 
 
Websites often ask you to apply to them to be able to use them fully. This is especially the case 
for job search websites. Typically these websites will require that you have an email address 
when you register to them. Quite a few other websites will require this as well, so we 
recommend, as a time-saver, to go ahead and obtain an email account before you begin filling 
out your online form. See the e-mail section of the FAQ on page 19 for how to get a free e-mail 
address.  The amount of information in the form may vary from time to time, but here are a few 
things to keep in mind about forms. 
 
The number one rule is:  DO NOT PUSH ANY OF THE FOLLOWING: The back button, the 
refresh button, the close button, or the enter key. In the case of the first three, you run the risk of 
the computer wiping out everything you've filled out so far. Countless times in the lab we have 
someone bump the back button and get upset that they've lost their entire work. Pressing the 
enter key can have detrimental effects for other reasons – it might cause the computer to try to 
submit the whole form, regardless of whether you've finished it or not. 
 
For a blank that you need to type in, point your mouse to that blank, click, and then you will get 
a blinking line that indicates you can start typing. For a box that has a downward pointing arrow 
next to it, clicking on that arrow gives you a list of choices, and you can then click on your 
selection. 
 
Some forms are very long, and might go onto two pages. Others are very short and just want 
your e-mail address. Sometimes there will even be optional information, and the page will mark 
the fields you must fill in with, for example, a red star. 
 
 
How do I send them my resume? 
 
Job search websites will ask for your resume in one of three ways. They might even give you a 
choice out of two of these: 

1) They might have a way to build your own resume on the site. CareerLink does this, but 
not many websites will. 

2) They will ask you to put it in plain text, in a box they have on the page. You can copy-
and-paste your resume into that box, but it might not look very good. 

3) There will be an option to upload a file. This method usually has a button marked 
“Browse”. If you push that, it will ask you to find the file you created your resume in. 
(This obviously assumes you have made a resume in Word or another program.) 
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E-MAIL (Creating an E-mail Address) 
 
What is e-mail? 
 
E-mail, or electronic mail, is almost identical to sending letters through the post office, but 
without having an actual piece of paper in your hand, without paying postage, and without 
waiting very long for it to go through. In fact, e-mail is so quick normal mail is often called 
"snail mail". 
 
 
How do I send an e-mail? 
 
Before sending an e-mail, you need an e-mail address. This is similar to having a mailbox on the 
side of the street or a P.O. box in the post office. 
 
 
What does an e-mail address look like? 
 
An internet address is usually www.somewhere.com 
An e-mail address is usually yourname@somewhere.com 
 
Note the difference between the two. An e-mail address is always someone *at* somewhere 
*dot* com. (The com could be net or edu or a few other things, but usually com.) The part before 
the "at" symbol is called the username and the part after it is the domain name. 
 
 
How do I get an e-mail address? 
 
If you have internet access some place else, you might already have one. Internet Service 
Providers (ISPs) usually give people an e-mail account, and workplaces sometimes give them to 
office workers. Those typically use an address that is like having a street mailbox. 
 
The other way to get e-mail is more like the post office box, and that is what we recommend in 
the lab for people who need an e-mail address. Some websites, such as Yahoo!, Google, Hotmail 
and a few others will allow you to get a free e-mail address from their website. The nice part 
about this is that it can be accessed from any computer. The other kind is typically stuck on one 
particular computer, since you need to set up the computer to know how to receive your mail. 
 
 
So it's free? Where do I sign up? 
 
In the lab, we typically steer patrons toward the Yahoo mail. To use Yahoo, you will want to 
open Internet Explorer, which will automatically go to Yahoo's homepage. Click on "My Mail" 
and it will go to the mail log-in screen. If we had an e-mail address already, this would be where 
we would go to access it. Instead, you'll notice along the right side of the screen, either above or 
below the log-in blanks, there will be the words "Sign up". Click on that. 
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At this point you will have to fill in a form. Yahoo needs to know a little bit about who you are 
before they give you an e-mail account, so click in each blank and fill it in. Leave preferred 
content the way it is. When filling in the line "Yahoo ID", this will be the username part of your 
e-mail address. The domain name will be yahoo.com. So your e-mail address will be 
WhateverYouTypeInRightNow@yahoo.com 
 
Unfortunately, it's not quite that simple. Millions of these Yahoo addresses already exist, and you 
cannot duplicate one that already is in use. In addition, Yahoo is rather picky and doesn't want 
your username to look like somebody else's, so what might seem like it should be acceptable 
might not be. After you type in one thing you want to try, press the button that appears below it 
"Check availability of this ID". It will either tell you your choice is alright, or it will give you a 
request to try again and might even give you a few usernames that will work, which will 
probably be similar to your name. Note that you cannot have any symbols in your e-mail address 
other than one period or an underscore, which looks like this: _ 
 
Beyond that, you will also need a password so nobody else can look at your e-mail. Type 
something that has at least six letters or numbers (and isn’t part of your name or username.) It 
will appear as dots when you type so somebody watching you won't know what you are typing. 
 
The section below that is your security question. This is very important, so take this seriously. If 
you forget your password, this is the only way to get back into your e-mail address. If you tell 
Yahoo you've forgotten your password, they will ask you a question so they know it is you trying 
to get in. You choose that question right now, so pick something that you will know the answer 
to any day of the week. 
 
Fill in the next couple items so Yahoo knows just a little bit about you, leaving the "Alternate e-
mail" line alone, and then you will have to type the letters and numbers in the weird squiggly 
picture below it to verify you are not a computer program signing up free e-mail addresses. 
Capital letters matter. If you mess up, you'll be asked to try again with a different picture, so 
don't worry. 
 
Finally, the terms of service at the bottom will ask you to agree to be a reasonable human being 
with your use of your e-mail account, and not send nasty or annoying things to other people. 
Click "I agree", and assuming that everything in your form was filled out OK, you will have an 
e-mail address! 
 
Write down your username and your password on a small slip of paper you can put in your 
wallet. We can not get your username back if you've forgotten, and the password is a bit of a 
nuisance to recover. 
 
 
That's too complicated. Can you just do it for me? 
 
No. The lab staff can help you if you are stuck on something, but we unfortunately we do not 
have time to go through the whole process with you. 
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E-MAIL (Sending/Receiving) 
 
 
I’ve got my e-mail address set-up. So how do I send an e-mail? 
 
In the upper-left part of the screen should be two buttons “Check Mail” and “Compose”. Check 
Mail is for reading e-mails sent to you. Compose is for writing and sending out e-mails, so click 
compose. 
 
There will be several blanks that appear in the center of the screen. “To:” is where you type the 
e-mail address of the other party. “Subject” is where you explain the purpose of the e-mail – just 
a quick words like “getting together on Thursday” or “family photos” so the other person knows 
that your e-mail is not spam. 
 
And then down in the big blank at the bottom, type the actual letter you want to send to the other 
person. When you are finished typing, press the Send button either at the top or the bottom of the 
page. You will get a message saying the message is sent, and the other person should get it very 
quickly. 
 
 
What’s spam? 
 
Junk mail. You will potentially start getting random junk mail about anything and everything. 
Some are complete gibberish. If you get anything that doesn’t have a meaningful message or is 
sent from someone you don’t know, you should probably just delete it…even if it tells you that 
you have won a free laptop or a thousand dollars. 
 
But we’re getting ahead of ourselves. 
 
 
How do I read my messages? 
 
Click on the “Check Mail” button or the “Inbox” on your list of folders down the left. You will 
get a list of all the new e-mails you have, including the sender, the subject, and the date. If you 
want to read a particular e-mail, click on the subject for it and it will open up to show it to you. 
 
 
How do I respond to a message? 
 
When you are reading an e-mail, you can respond to it by simply pressing the “reply” button. 
Note that this looks just like the Compose screen, except that parts of the screen are already filled 
in, and the old message is already in the body of your e-mail. It works the same way. 
 
Also notice that the subject has the letters “Re:” added to the beginning. This means “regarding” 
or “in response to”, and lets the other person know that this is a reply to their e-mail. 
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Do messages go away after I read them? 
How do I delete a message? 
 
After you read a message in your in-box, it stays there. When you first log into your e-mail, it 
may have said “Inbox (1)” in bold letters. This means you have one message that hasn’t been 
read yet. It does not mean there is only one message there. 
 
In order to keep your e-mail organized, you should delete anything you no longer need. In the 
case of most e-mails, this is right after you have read them. While reading an e-mail, there is a 
delete button near the reply button. The other way to delete is in your in-box. Next to each e-mail 
is a checkbox. If you click the checkbox for one or more e-mails, and then press the delete 
button, it will toss them. 
 
 
If I delete an e-mail, is it gone for good? 
 
It goes to the trash folder. Down the left side of the screen is your list of folders. If you need to 
get to something you’ve deleted, it will stay in trash for a little while before Yahoo cleans it out. 
If you accidentally delete something, you can check your trash folder and move the mail back to 
your Inbox.. 
 
 
Can I send an e-mail to more than one person? 
 
In the “To:” line where you type the e-mail, type the first e-mail address, a comma and a space, 
and then the second e-mail address. (And then a comma and a space, and then the third e-mail 
address…) 
 
You can also send a “carbon copy” to someone who is getting the e-mail just for their own 
reference. Click “Add CC:” above the To: line and you will get a line just like it for Cc: where 
you can type the other person’s e-mail address. 
 
 
I’ve got some letters in front of the subject of this e-mail. What do they mean? 
 
There are a bunch of abbreviations used in the e-mail world, including: 
Re: --  indicates a response to an earlier e-mail 
Fw: -- forward, meaning this e-mail was sent to that person, who is now sending it to you 
Cc: -- carbon copy. While you are not the primary person the e-mail is being sent to, this e-mail 

also concerns you on some level 
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What’s an attachment? 
 
You can send more than just letters in e-mail. You can also send packages. In the computer 
world, this means you are sending a file along with your e-mail. This can be a Word document 
you just typed, a picture from your digital camera, or any number of other things. 
 
 
How do I send an attachment? 
 
Pretend like you are sending an e-mail to the person you want to send the attachment to, but 
don’t press the button to actually send just yet. Instead, look below the subject line for a button 
for “Attach files”. This will take you to another screen. 
 
The computer will then want to know what you are attaching. Press one of the buttons marked 
Browse, and look through the folders for the file you want. Click on it and press the Open button 
in the corner. If you have more than one file to do, click another browse button and repeat this 
process. When you are finished, press the Attach Files button and the computer will pause for a 
moment while it sends those files to Yahoo’s mail servers. (In other words, the post office.) 
When it appears, press the “Continue to message” button, and you will now have the files 
marked with a paper clip icon, just below the subject line. They will go out along with the e-mail 
that you send. 
 
 
How do I receive an attachment? 
 
You will know an e-mail has an attachment if it has a paper clip next to the subject when you 
look at it in the inbox. Be careful with e-mails that have attachments: the easiest way to get a 
virus on your computer is to open one in your e-mail. Because of this, it is strongly 
recommended that you immediately delete any e-mail with an attachment coming from an 
unknown source, or if you don’t know what the attachment is. 
 
If you are sure you want the attachment, open the e-mail, scroll below the actual message to the 
section for attachments, and click on the name of the file. Yahoo will probably ask you if you 
want to save or open the file. Pressing Open will look at it now, pressing Save will store it onto 
your computer. Take your pick. 
 
 
How do I know if I’m getting a virus? Is my computer safe? 
 
Don’t get paranoid. The lab computers are perfectly well-protected. (We don’t let you do 
anything that could harm the computer.) At home, if you have an anti-virus program, you are 
probably safe, but to be sure just delete anything coming from a strange source and you will be 
fine. If you really want to get advanced, you are probably alright as long as you do not download 
an attachment that is an “.exe” file. Those are programs. A virus has to be able to run initially to 
be able to do anything, so stay away from those executables! 
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MICROSOFT WORD 
 
 
What is Microsoft Word? 
 
MS Word is a word processor, meaning it is a program used for creating documents such as 
letters, resumes, essays, and proposals. It can be used for a good many other things, such as 
signs, charts, greeting cards, and tables, but there are other programs such as Excel and Publisher 
which are designed for those sorts of things. So simply put, Word is a typing program. 
 
 
How do I make stuff in it? 
 
When you first open Word, you will have a blank page to work from. Refer to page 9 for details 
about the actual art of typing. 
 
If you need to change the appearance of something, highlight it first, and then use the buttons on 
the toolbars to alter that highlighted section. Note that you can point to a button without clicking 
on it to find out what it does. In particular, notice the Font button (that probably says “Times 
New Roman”, the Font Size next to it, the B, I, and u buttons, and then the four buttons after 
those that change whether the words are lined up along the left, right, or if they are centered. 
 
If you need additional controls of the style of your document, try pointing your mouse to each of 
the buttons in the toolbars, looking at the different choices in the menus, or using Microsoft 
Word Help. The Help menu is the last item on the menu bar, and can give you pointers on how to 
accomplish something if you can’t figure it out. Help isn’t always easy to understand, but it will 
give you a way to find your answer. Feel free to also consult with the lab staff about advanced 
features in Word. 
 
 
Do I have to make everything from scratch? 
 
No, you could try using a “template”. Templates are documents that are already set-up for you, 
and you just need to fill in the blanks. For example, the template for a calendar just asks you 
which month you want, and then it creates the entire calendar for that month. (You then have the 
option of adding other things to it.) 
 
To access templates, go to the File menu in the upper-left and select “New…”, which will give 
you a menu on the right side of the screen. Under the heading New from templates, choose 
General Templates. This will give you a menu where you can choose for quite a few different 
types of templates. Make your selection by clicking on it and then clicking on the OK button. 
 
If you are trying to create a resume, the computer lab staff does not especially like the templates 
for resumes that are provided with Word, so we have made our own. On the desktop, we have 
placed a shortcut to our resume templates. 
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Why did the words turn red? (or green?) 
How do I run spellchecker? 
Why did the computer change what I did? 
 
Computers are very good at doing what they are supposed to, but they aren’t actually very smart. 
The programmers at Microsoft gave the computer a list of words that is can safely assume are 
spelled right. If the computer sees anything not on that list, it assumes it is wrong. The red 
squiggles underneath a word are to indicate to you that the computer doesn’t recognize the word, 
even though the word might be perfectly fine. Your last name, for example, might not be a word 
the computer will recognize, even if you know how to spell it. 
 
If a word or sentence gets a green squiggle instead, this means the computer has detected some 
kind of issue with grammar. The computer is often wrong about grammar errors, since it does not 
try to understand your intent. It often sees abbreviations like “Mr.” as the end of a sentence and 
expects the next word to start a brand new complete sentence (and be capitalized.) 
 
If you have a mistake, you can do one of two things. Either you can right-click on the section in 
question, and the computer will give you a set of suggestions at the top of the menu that appears, 
or you can just run the spellchecker at the end. The spellchecker will probably run through your 
entire document checking words. It will show you what is wrong on the left, and give you 
choices on the right for what can be done about fixing what is actually a mistake or making the 
computer ignore what it thinks is one. 
 
On the subject of fixing mistakes, there are some errors the computer will fix automatically as 
soon as you make them, such as typing ‘teh’ when you mean to type ‘the’. This is called 
AutoCorrect. If the computer changes something you don’t want it to, immediately press the 
backspace key, or go back and change it manually. 
 
 
What do I do when I’m done? 
 
Under the File menu and then… 
 
Choose Print if you want to print your work. The screen that appears gives you a lot of choices 
about how you want to print. (How many copies, which pages, etc.) 
 
Choose “Save As” to store your work onto a floppy disk. We strongly recommend you do this 
even if you are printing unless you are absolutely certain you will not need this work ever again, 
in case you need too fix a misteak yoo mihgt haev maid wen tieping. 
 
To finish the saving process, you will need to make the sure file has a name and the correct 
destination. The destination should be “3 ½” Floppy (A:)”, which it will already be if you had 
your disk in when the program started. If it doesn’t say that, click on the box next to the words 
“Save in…” and click on the option for the floppy. Then give the file a name by clicking in the 
blank for File Name, deleting the name the computer tries to give it, and typing in the name. 
When you are finished both steps, you can click on the Save button or press the enter key. 
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